
Overview
 CCD Commander is an automatic imaging tool for CCD imagers.  It can complete your entire imaging
session without any user intervention.  This translates to more images and more rest!  With CCD
Commander you can image one object, or several objects throughout the night, moving the telescope,
focusing, and imaging as required. 
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Requirements
 CCD Commander takes advantage of other programs to automate your imaging session. 
 These programs are required to run CCD Commander: 
TheSky6 v6.0.0.33 or later (Professional Edition only) by Software Bisque  http://www.bisque.com
 or 
TheSkyX v10.1.8 or later (Professional Edition only) by Software Bisque  http://www.bisque.com
 or 
ASCOM Telescope driver v2 or later  http://www.ascom-standards.org
  CCDSoft v5.00.182 or later by Software Bisque  http://www.bisque.com
 or 
MaxIm DL v4.11 or later (including v5.xx & v6.xx) by Diffraction Limited  http://www.cyanogen.com
  If you have an motorized focuser, CCD Commander will use: 
FocusMax v3.3.29 or later by Larry Weber and Steve Brady  
v3.2.1 Installer available here: http://www.focusmax.org
 v3.3.29 patch available here: http://ccdcommander.astromatt.com/FocusMax3329.zip
 Latest version available here: http://tech.groups.yahoo.com/group/FMaxUG/files/
 CCDSoft v5.00.182 or later @Focus or @Focus2 by Software Bisque  http://www.bisque.com
 MaxIm DL v5.08 or later Focus by Diffraction Limited  http://www.cyanogen.com
 TheSkyX v10.1.8 or later (Professional Edition only) by Software Bisque  http://www.bisque.com
 If you do not have a motorized focuser, CCD Commander can still be used without the ability to
automatically focus. 
 If you have an instrument rotator, CCD Commander will use: 
Optec Pyxis  http://www.optecinc.com
 Astrodon TAKometer  http://www.astrodon.com
 RCOS PIR  http://www.rcopticalsystems.com
 ASCOM Rotator driver v1 or later  http://www.ascom-standards.org
 If you do not have an instrument rotator, CCD Commander can be used without the ability to rotate. 
 If you have a dome, CCD Commander can use: 
Automadome by Software Bisque  http://www.bisque.com
 Digital Dome Works by Technical Innovations  http://www.homedome.com
 ASCOM Dome driver v1 or later  http://www.ascom-standards.org
 If you do not have a dome, CCD Commander can be used without dome control. 
 If you have a cloud sensor, CCD Commander will use: 
Boltwood/Clarity Cloud Sensor  (version I or II) http://www.cyanogen.com
 AAG Cloud Watcher http://www.aagware.eu/aag_cloudwatcher.htm
 If you do not have a cloud sensor, CCD Commander can be used without cloud monitoring. 
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Getting Started
 CCD Commander is a robust executive program.  In order to work correctly, the other software CCD
Commander manages must be first configured.  Before you use CCD Commander for the first time,
setup your software as described below. 

1.
1.  If you want to use CCDSoft: 

1.
1. Enable Events in CCDSoft.  

1.
1. Run CCDSoft. 
2.
2. In the Camera Control window, on the Setup check to see if there is a button called

"Event Plug Ins..."

2.
3.
3.  If not, you need to create a folder in your CCDSoft program directory. 

1.
1. Using Windows Explorer, go to this directory on your PC.  
1. ex: "C:\Program Files\Software Bisque\CCDSoft Version 5" 
2.
2. Create a folder named "Camera Event Plug Ins". 

4.
4. Restart CCDSoft and check that the "Event Plug Ins..." button now shows.

2.
2.  If you want to use TheSky6: 

1.
1. Setup the "Server Settings" in TheSky6. 

1.
1. Run TheSky6. 
2.
2. Go to the Telescope->Server Settings menu. 
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3.
3. Enable "Allow sync", "Allow goto", and "Allow park".  Make sure these three items have

check marks next to them.  

3.
4.
4.  Click Ok.

2.
2.  Setup your telescope's Park position in TheSky6.
2. CCD Commander will use 
2. the Park function when a major problem has occurred.  This should prevent damage from the

mount colliding with something.  If your mount does not support the Park function in
TheSky6, please let me know. 
1.
1. First test the park function - you might not need to do anything.  If 
1. you need to setup the Park function, TheSky6 will tell you.  
2.
2. Slew your telescope to the desired "Home" position. 
3.
3. Click the Telescope->Options->SetParkPosition menu item.

3.
3.  Start CCD Commander!
3. (All other software tools, e.g. MaxIm/DL, TheSkyX, FocusMax, etc., do not require any

additional setup with CCD Commander.) 
 Now you can setup CCD Commander for use with your system.

1.
1.  Setup the program settings in CCD Commander. 

1.
1. Click the Setup menu. 
2.
2. Click on the Control/Device tab.  For help with these values click here
2. . 
3.
3. Select your Camera Control program from the drop-down list. 
4.
4. Click the "Get Filters From..." button to pull in your filter descriptions from the camera

control program. 
5.
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5. Select your Mount Control program from the drop-down list.  Be sure to push the Configure
button for the ASCOM Driver. 

6.
6. Select any other programs you wish to use.

2.
2.  Setup your mount parameters in CCD Commander. 

1.
1. Click the Setup menu. 
2.
2. Click on the Mount Parameters tab.  For help with these values click here
2. . 
3.
3. S
3. elect your mount type. 
4.
4. German Equatorial Mounts have additional setup values required in the "GEM Setup" box. 

1.
1. The "Eastern Limit" and "Western Limit" values are very important and tell CCD

Commander when a slew will send the mount to the eastern or western side.  The easiest
way to set these parameters is to manually slew your mount to its limits and read the RA
position it is pointing to.  Then compute the difference from the current sidereal time.  I
was able to do this in The Sky using the Motion Controls window.  Force the mount to
one side of the meridian, slew to the limit, and find out how far from the meridian the
mount is.  Do this for both the eastern and western limits. 

2.
2. Next tell CCD Commander which side of the meridian you calibrated the autoguider on.

3.
3.  Setup the Plate Solve parameters in CCD Commander. 

1.
1. Click the Setup menu. 
2.
2. Click on the Plate Solve tab.  For help with these values click here
2. . 
3.
3. Select your Plate Solve program from the drop-down list. 
4.
4. Enter the appropriate values for the "Pixel Scale" and "North Angle". 

1.
1. CCDSoft users can pull these values from a previously solved image still open in

CCDSoft. 
5.
5. PinPoint users need to select the location of the star catalog to use. 
6.
6. MaxIm/PinPoint LE users need to specify a time-out value.

4.
4.  Setup any of the other parameters you need to use in the Setup window. 

 CCD Commander is now setup and ready to use!  Click here
 to learn more about CCD Commander's functionality. 
 NOTE: With the release of v1.2, some users experienced an error when running an Action List in CCD
Commander.  The error is reported as, "Error Number: 70" and "Permission Denied".  This error is the
result of a Windows permission setting.  Look here
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 in the Troubleshooting section to see how to correct the setting and the error. 
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Control/Device Setup

  Camera Control selects the program you want to use to control your CCD camera.  Based on your
selection, some items throughout CCD Commander can change. 
 Special Note: There is two selections in the Camera Control
 drop-down menu for CCDSoft.  One is "CCDSoft v5" and the other is "CCDSoft v5 (w/AO)".  This
latter option should be selected when you are using any of the AO devices in CCDSoft in order to
achieve the maximum guide rate possible. 
 The Filters list shows the current filters installed in your filter wheel (if available).  If you do not have a
filter wheel, the Filters list should be empty.  You can automatically pull the filter definitions from your
camera control program by using the Get Filters from... button.  If you want to define the filter names in
CCD Commander manually, you can use the Add Filter and the Delete Filter
 buttons.  To change the description of a filter already in the list, simply double click on the filter in the
list. 
 Checking Ignore "Star Faded" messages from MaxIm/DL will disable the feature where CCD
Commander checks the "Star Faded" 
messages sent by MaxIm/DL. 
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 If the "Star Faded" 
messages are not ignored, you can set the maximum number of messages CCD Commander will allow
before generating an error. 
 Checking Ignore "Exposure Aborted" messages from MaxIm/DL 
will disable the feature where CCD Commander checks the "Exposure Aborted" messages sent by
MaxIm/DL. 
 Disable dummy image on filter change 
will prevent CCD Commander from taking a dummy image to force a filter change.  For cameras with
filter wheels checking this option may cause problems when changing filters.  For other cameras that use
filters as a way to use some other functionality (i.e. ISO with a DSLR), this option may improve
performance. 
 The 
Guider is Internal Guider checkbox should be checked if you are using a self-guiding SBIG camera. 
CCD Commander needs to adjust its control of the guider when a self-guided camera is in use. 
 Mount Control selects the program used to control the mount.  If you are using the ASCOM Driver, you
must use the Configure
 button to choose which driver you want CCD Commander to use. 
 Planetarium selects the program to use for the planetarium functions (object catalogs, FOVI position
angles, etc.)  If you select None
 here, some functions in CCD Commander may be disabled. 
 Focuser Control selects the program used to control the focuser.  If you do not have, or do not want to
use an automatic focus routine you can set this to 
None. 
 Instrument Rotator selects the type of rotator you are using.  If you do not have a rotator you can set this
to None.  When you select a rotator, the Rotator tab will become enabled.  If you select the RCOS PIR 
you should use the Configure
 button to setup the driver. 
 Dome Control selects the type of dome control interface in use.  If you do not have a dome, or you are
going to use a custom dome control set this to None.  When you select a dome control interface, the
Dome tab will become enabled.  If you select the ASCOM Driver, you must use the Configure
 button to choose which driver you want CCD Commander to use. 
 Wether Monitor selects the weather monitor you are using.  If you do not have a wether monitor or
cloud sensor, set this to None.  When you select a weather monitor, the 
Weather Monitor tab will become enabled. 
 Checking Disconnect from all programs/devices at end of action list.
 will cause CCD Commander to disconnect from each of these programs/devices when the action list is
completed - allowing a safe exit from any of the other programs prior to closing CCD Commander.  This
can cause some unwanted behavior - as the disconnect operation may cause the other program to close. 
Disable this checkbox to ensure that all the other programs stay open until you exit CCD Commander. 
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Plate Solve Setup

  Here you select the method CCD Commander should use to Plate Solve images. 
 Note: 
The MaxIm/PinPoint LE selection uses the MaxIm GUI interface to execute a plate solve.  This method
works, but is very sensitive to other programs running at the same time.  Also it will not work if you are
manually using the computer to perform other tasks.  The other plate solve choices are much more robust
and should be used if possible.  Try the other choices and use this combination only if the others do not
work. 
 Unbinned Pixel Scale
 is passed by CCD Commander to the Plate Solve program.  CCD Commander will pull the image
coordinates from mount.  Perform a Plate Solve function manually to get an accurate value for Pixel
Scale.  Enter the reported number into this field. 
 North Angle is used by CCD Commander to help in determining if the Plate Solve was successful.  Even
though the Plate Solve program thinks a solution was found, knowing the correct North Angle is a final
check to confirm the result.  CCD Commander will compare the entered value for North Angle with that
reported after the Plate Solve.  If the results are significantly different, CCD Commander will abort the
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action and move on to the next action in the list.  To determine a correct value for the North Angle,
perform a Plate Solve manually.  Enter the value reported into the North Angle field.  Be sure to use the
same program you specified for CCD Commander to use as different programs report the 
North Angle differently. 
 The Get button is available only when using CCDSoft/TheSky for Plate Solves.  CCDSoft reports a
different value for North Angle to the user than it does over the programmable interface.  As a result it is
difficult to get the proper value into CCD Commander.  The Get allows CCD Commander to
automatically get the Unbinned Pixel Scale and North Angle from a manually solved image in CCDSoft. 
To use this feature, first manually take an image in CCDSoft and execute an Insert WCS function on it. 
When complete, be sure to confirm your that your result is correct.  With the image still open in
CCDSoft, click the Get
 button in CCD Commander to retrieve the parameters. 
 Disable North Angle Verification  will turn off CCD Commander's checks for the North Angle
.  It is not recommended to disable this verification.  However if you are running a portable setup and do
not have an accurate polar alignment it may be necessary as your actual North Angle may drift over the
night. 
 Pin Point (full) Setup 
The full version of Pin Point requires that CCD Commander know some information about the star
catalog you are using.  You can specify that information here. 
 Catalog selects the star catalog you want Pin Point to use. 
 Path
 specifies the location of the catalog.  Click the "..." button to browse to the location of the catalog.  See
the Pin Point documentation for full details. 
 Catalog Stellar Magnitudes specifies the star magnitude range to use from the catalog.  NOTE: 
This is an advanced parameter that should be used only if you have problems plate solving.  The default
value should work in most cases. 
 Search Area (% of image)
 tells PinPoint how large an area to search when trying to match your image.  100% means that PinPoint
will only search an area equal to the size of your image.  If your mount continuously places the target near
the center of your sensor, you can set this value to 100%.  If your target often lies near the edge of your
sesnor or off the sensor, you should increase this value appropriately.  A larger Search Area will increase
the amount of time required for a plate solve. 
 Maximum # of stars used
 specifies the total number of stars used from your image to perform the plate solve.  If you have a very
wide field image and/or a large sensor, setting this to a small number may decrease the time required to
perform the plate solve.  A value of 0 will use all the stars in the image (this can cause long plate solve
times for large sensors). 
 Standard Deviation above Background 
specifies the standard deviation threshold above which a star must be above in order to be detected by
the PinPoint algorithm.  Noisier images should increase this value to help discern the stars from the noise. 
 Pin Point Full & LE Setup 
Maximum Time
 specifies the amount of time CCD Commander should wait for PinPoint to return a solution.  If no
solution is found within the time-out limit, CCD Commander aborts the plate solve attempt. 
 Retry timed out attempts 
if checked will allow CCD Commander to retry one time a failed plate solve attempt. 
 Dark subtract all plate solve images
 when enabled will cause CCD Commander to take a dark frame for the plate solve exposure and do a
dark frame subtraction. 
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Mount Parameters

  Select the type of mount you are using.  Select Fork Mount for any type of mount that can track and
slew constantly through the meridian.  Select German Equatorial Mount
 for any type of mount that requires a "flip" at the meridian. 
 The Delay after slew
 entry tells CCD Commander to wait an additional period of time after the slew completes.  This is useful
if a dome needs extra time to catch up to the mount movement. 
 The Disable Guide Declination Compensation
 will cause the Declination setting in CCDSoft or MaxIm to be set to 0 while autoguiding.  This will
disable any declination compensation to the guide star corrections. 
 The 
GEM Setup box contains additional parameters for German Equatorial Mounts. 
 The Eastern Limit and Western Limit
 values are very important and tell CCD Commander when a slew will send the mount to the eastern or
western side.  
 The easiest way I have found to determine the Eastern Limit and 
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Western Limit is as follows: 
1.
1. Position the mount with the telescope on the East side of the mount, looking at the Western sky. 
2.
2. Slew to a target just East of the meridian (it helps to use a planetarium to determine a target). 
3.
3. If your mount flips, then your Eastern Limit 
3. will be 0 (or very close to it).  Skip to Step 7. 
4.
4. If your mount does not flip, pick another target slightly further East.  Slew to this target. 
5.
5. Repeat step 4 until your mount flips.  Your Eastern Limit will be the difference between the target

RA and the Local Sidereal Time.  (Eastern Limit 
5. must be 0 or positive.) 
6.
6. Now position the mount with the telescope on the West side of the mount, looking at the Eastern

sky. 
7.
7. Slew to a target just West of the meridian. 
8.
8. If you mount flips, then your minimum Western Limit 
8. is 0. 
9.
9. If your mount does not flip, pick another target slightly further West.  Slew to this target. 
10.
10.Repeat step 9 until your mount flips.  Your minimum Western Limit will be the difference

between the target RA and the Local Sidereal Time.  (Western Limit 
10.must be 0 or positive.) 

 The Western Limit serves a second purpose - telling CCD Commander how far past the meridian you
can track.  Some mounts will come up with a value of 0 for the Western Limit using the above
procedure, but the Western Limit could be larger.  Now with your telescope on the West side of the
mount, slew your telescope until it hits its safety limit (or just before it hits the tripod/pier).  Determine the
RA your telescope is looking at.  Now determine the difference between the telescope RA and the Local
Sidereal Time.  This is your maximum Western Limit
. 
 You should set the Western Limit
 value anywhere between the minimum value determined in steps 8-10 above, and the maximum value. 
 When you start an action by pushing the Start Action button on the main window, CCD Commander
needs to determine what side of the mount your telescope is on.  Normally this determination is easy. 
However, if the telescope is in the zone defined by the Eastern Limit and Western Limit values, it can be
on either side of the mount.  CCD Commander needs to determine which side of the mount the telescope
is on for proper operation.  When Automatically determine mount side at start-up
 is checked, CCD Commander will slew the telescope to force it to one side or the other.  CCD
Commander will always slew the telescope to the "normal" side of the mount given where it is pointing.  If
the telescope is looking to the eastern sky, CCD Commander will force the telescope to the west side of
the mount.  If the telescope is looking to the western sky, CCD Commander ill force the telescope to the
east side of the mount. 
 Unchecking Automatically determine mount side at start-up check box allows you to specify the mount
side at startup when the telescope is in the "overlap" zone defined by the Eastern Limit and Western Limit
 values.  The following window will be shown when the telescope is in the "overlap" zone. 
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  You must specify the correct side of the mount that the telescope is on.  Alternately, you can allow the
automatic procedure, described above, to force the mount to one side automatically. 
 The next selection tells CCD Commander which side of the meridian the autoguider was calibrated on. 
This selection also applies to the angles in the Rotator
 tab.  It is very important for all of these values to be calibrated/computed on the same side of the
meridian. 
 The Enable Slew Scripts check box allows you to specify a custom script to run before any mount
movement and after any mount movement.  This can be very useful for dome users that do not want the
dome to rotate until the mount has finished moving.  Once you check this box you can select the scripts
by clicking the "
..." buttons. 
 Note: The Park Mount action only executes the Before Slew
 script. 
 When Verify telescope coordinates after Move To action
 is checked, CCD Commander will query the telescope coordinates at the end of the slew and compare
them to the Right Ascension and Declination that the telescope was supposed to slew to.  Occasionally a
minor error can prevent the telescope from reaching its desired coordinates, and this will trap those
conditions.  When the coordinates do not match, CCD Commander will slew to your target a second
time.  If the slew fails again, CCD Commander will skip ahead to the new Move To action in your list. 
 Maximum acceptable telescope pointing error specifies how close the telescope coordinates must be to
the target Right Ascension and Declination in the above verification.  If you are using a pointing corrector
such as TPoint, you might need to increase this value.  TPoint adjusts the telescope pointing to put it
properly on target, but doesn't adjust the telescope reported coordinates.  Thus the telescope can report
coordinates off target, yet still be pointing at the proper location. 
 It is recommended to leave the Verify telescope coordinates after Move To action enabled with the
default Maximum acceptable telescope pointing error unless you experience problems with these settings.
When you have slew failures due to the coordinates not matching, first try to increase the 
Maximum acceptable telescope pointing error to a value specific to your mount. 
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Automatic Guide Exposure

  This window is to setup the parameters for the Automatic Guide Exposure function in CCD
Commander. 
 If this function is enabled, CCD Commander will always automatically try to find a suitable guide star
and guide exposure whenever the autoguider is enabled in a Take Images
 action. 
 The Minimum Guide Exposure and Maximum Guide Exposure
 entries tell CCD Commander what range of exposure times are valid for the autoguider.  
 The Maximum Guide Exposure Increment limits the change CCD Commander will make to the guide
exposure as it searches for a guide star.  CCD Commander will always start with the Minimum Guide
Exposure value.  Each successive increment in the guide exposure will always be less than or equal to the
Maximum Guide Exposure Increment
. 
 The minimum time is usually dictated by how well your seeing is.  For poor seeing, the minimum time
should be longer so that the autoguider does not "chase the seeing".  
 The maximum time is usually determined by how long your mount can accurately track without receiving
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a guide correction.  This value should be 2 to 4 times smaller then your maximum unguided exposure
time.  If your mount can track well for 4 minutes unguided, you can comfortably set the Maximum Guide
Exposure
 to 60 seconds or more. 
 The Minimum Guide Star Brightness and 
Maximum Guide Star Brightness values tell CCD Commander what range of brightness values the guide
star should fall into.  Note that CCD Commander looks at the maximum brightness of the star recorded
by the guide CCD.  This means that, given the same star, the computed exposure time can vary
depending on how the star falls on the guide CCD pixels.  
 The minimum brightness value should be set to give sufficient a signal-to-noise ratio of the star such that
the guide algorithm can successfully track the star.  
It is important to note that all autoguider centroid calculations work better as the guide star
signal-to-noise ratio increases.  This means that brighter guide stars can provide better guiding accuracy
than dimmer guide stars.  Keep this in mind when setting your minimum brightness. 
 The maximum brightness value should be set such that the star never saturates the guide detector. 
 The Guide Box X Size and Guide Box Y Size
 specify what size window CCDSoft uses to track the star.  It is important for CCD Commander to
know this because it will check a box this size about a potential guide star for any other stars that might
impede CCDSoft's tracking ability.  In addition, CCD Commander will not pick a star that is too close to
the edge of the guider since CCDSoft could move the mount significantly to bring the guide star far
enough away from the edge for the guide box to fit. 
 You can change the size of the guide box CCDSoft uses.  Software Bisque has documented this
procedure here
. 
 For MaxIm the default guide box size is 32x32.  Change the value in CCD Commander to match the
value you have selected in MaxIm. 
 The Typical Guide Star FWHM
 indicates the size, in pixels, of the typical guide star.  CCD Commander uses the value help determine
where the edge of a star is, and where another star may begin.  The default value is sufficient in most
circumstances and should not need to be changed.  But if your guide stars are significantly larger than 4
pixels in any axis, then increase this value. 
 The Ignore 1-pixel Stars
 checkbox will cause the search algorithm in CCD Commander to disregard stars that occupy only 1
pixel.  This is especially useful for guiders that have hot pixels - but can be a problem for short focal
length guide scopes where the guide star FWHM is <1 pixel.  Evaluate your guider images to ensure that
the guide star FWHM is routinely greater than 1 pixel before enabling this option. 
 The Maximum Star Movement between exposures
 entry tells CCD Commander how much a potential guide star can move between exposures and still be
considered valid.  In order to rule out cosmic ray hits and other anomalies, CCD Commander takes two
images of the Guide CCD in the search for a guide star.  CCD Commander will accept a guide star if its
centroid moves less then the amount specified here between the two exposures.  Be cautious increasing
this value - only do so if the default value causes CCD Commander to ignore real stars. 
 Checking Restart autoguiding when the guide error is more than...
 will tell CCD Commander to stop autoguiding and attempt to reacquire the guide star when the guide
error is larger than the specified error for the specified number of guide cycles. 
 The Continuous Autoguiding check box tells CCD Commander to never stop the autoguider during an
image sequence.  Not until the mount moves will the autoguide be stopped.  This is useful when you have
an external guider and want to guide continuously throughout the exposure for optimum speed.  Be aware
that when using an SBIG self-guiding camera, the guider will continue uninterrupted trough filter changes. 
It is not recommended to do this.  Instead disable 
Continuous Autoguiding to allow the autoguider exposure to be recomputed for each filter. 
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 Disable Automatic Guide Star Recovery
 will cause CCD Commander to always search for a guide star prior to starting autoguiding.  This is
useful if your mount is not able to get the guide star back into the guide box on a return slew. 
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File Options

  Global Image Save Location 
This specifies the location to save the images taken with CCD Commander.  Click the "
..." button to browse to the path you wish to save to. 
 Use MaxIm DL FITS Compression 
This enables the use of the FITS Compression function in MaxIm DL when saving images.  This can
reduce the FITS file size - but be aware it will render the FITS files incompatible with other software
packages, the resulting FITS files must be opened in MaxIm DL. 
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Rotator Setup

  Rotator COM
 specifies the serial port that the rotator is connected to.  CCD Commander supports COM ports from 1
to 255. 
 Home Rotation Angle is the position angle that the camera is at when the rotator is at an angle of 0
degrees.   If the top of the detector is north, then the Home Rotation Angle
 will be 0 degrees.  If the top of the detector is east, then this value is 90 degrees.  South is 180 degrees. 
Finally west is 270 degrees. 
 Similarly Guider Calibrated 
at specifies the detector angle where the guider was calibrated.  
 The Guider Calibrated at value only applies when the Guider rotates with Imager checkbox is checked. 
Guider Calibrated will be disabled when the checkbox is not checked.  If you use a guide scope/guide
camera, then you should uncheck this value.  When checked, CCD Commander will automatically
recompute the guider coefficients in the camera control program, allowing the guider to function at any
desired rotation angle.  When CCD Commander recomputes the guider coefficients for a new rotation
angle, the Guider Calibrated 
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at value will be changed.  Since the new coefficients are for a different angle that change needs to be
reflected here.  Once you enter this value and successfully use CCD Commander, you shouldn't need to
change this value or recalibrate the guider until you make a physical change to your setup. 
 Finally the Get Angle from TheSky6
 button will fill in either or both of the angles (depending on which checkboxes to the left of the button are
checked) from the angle of the FOV Indicator in TheSky6.  The easiest way to determine these values
and to get them entered it to perform the following steps: 

1.
1.  Connect your mount to TheSky6 and slew to a nice star field. 
2.
2. Enable your camera's FOV Indicator in TheSky6. 
3.
3. Take an image of the star field in your camera control program. 
4.
4. Copy the image to your clipboard (either using Ctrl-C or Edit->Copy). 
5.
5. Paste the image into TheSky6 (either using Ctrl-V or Edit->Paste). 
6.
6. Perform an Image Link in TheSky6 to link the image. 
7.
7. The Image Link will adjust the FOVI to the position angle of the image. 
8.
8. Push the Get Angle from TheSky6
8.  button in CCD Commander to pull the position angle from the FOVI. 

 GEM Users: Note the text on the page specifying what side of the meridian you should be on when
getting these values.  If your telescope was on the opposite side of the mount, select the opposite setting
in the Mount Parameters
 tab. 
 Fork Mount Users: The text specifying the side of the meridian will not appear on this window
. 
 Check the Guider sees a Mirror Image of the sky 
if the image on the guide chip is mirrored.  CCD Commander needs to know this to rotate the guide
vectors in the proper direction. 
 The Reverse rotator direction check box will tell CCD Commander that the rotator need to be moved in
the opposite direction than expected.  See Rotator Physical Setup
 below for more information. 
 The During "Move To" Actions that Flip the Mount section defines what CCD Commander will do with
the rotator when the mount flips.  When using an external guide scope, it is often useful to not rotate the
rotator except for framing.  In this case, the Maintain Rotator Angle (Rotator does not move) option is
ideal.  When guiding through the rotator (self guided or OAG) the Maintain Position Angle by Rotating
180 degrees 
option can be better (but is not necessary). 
 Rotator Physical Setup 
In order to function properly, the rotator must spin in the direction CCD Commander expects.  The
rotator must spin in the direction from North to East to South to West.   As you are looking up at the
sky, this is a counterclockwise rotation.  You can also confirm the proper direction by Image Linking one
image in TheSky6, increasing the rotator angle, and then Image Linking in TheSky6 a second time.  Just
like you increased the rotator angle, the position angle of the FOVI in TheSky6 should also increase. 
 If your rotator rotates in the opposite direction, check the Reverse rotator direction
 checkbox. 
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Dome/Roof Setup

  When the mount moves, the dome can sometimes have a difficult time keeping track of the mount
position - especially if you have a GEM and the mount flips sides as part of the slew.  During a GEM flip,
the dome can start off going to wrong way and then has to catch up to the mount after it flips. 
 When you enable the Uncouple the Dome during slews
 checkbox, CCD Commander will prevent the dome from moving until after the mount has completed its
slew.  Once the slew is complete, CCD Commander will then re-couple the dome to the mount and wait
(if possible) for the dome to report that its movement is complete.  For some slews this might make the
slew operation slightly longer, but for meridian flips it can greatly reduce the total slew time. 
 Always Park Mount before Closing Dome/Roof will cause CCD Commander to always
 issue a park command to the mount prior to closing the dome.  This is necessary if the dome/roof cannot
close with the mount/telescope in the "normal" operating position.  Enabling this options will help ensure
that the mount is parked prior to closing the dome/roof. 
 CAUTION:
  CCD Commander cannot necessarily guarantee that the mount is parked prior to closing the dome/roof.
If you have a setup where the dome/roof requires the mount and telescope to be in a specific position
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prior to closing, there should be fail-safes installed to prevent the dome/roof from moving when the mount
is in an unsafe condition.  CCD Commander will attempt to park the mount prior to closing the
dome/roof if this option is selected, but problems beyond the control of CCD Commander may cause
prevent this from happening. 
 When Halt on Dome Error is checked, CCD Commander will halt all operations and treat the Dome
Error as a general "Program Error".  CCD Commander will attempt to perform the functions in the
Program Errors tab.  When Halt on Dome Error 
is not checked, CCD Commander will report the error but will continue operation as normal.  
 DDW Retry Settings are for Digital Dome Works users.  The DDW control software often is unable to
complete an operation successfully.  These retry settings will allow CCD Commander to retry an
operation that never completed.  While the Operation Timeout value can be set less than the time needed
to complete an operation, ideally it should be longer than required to complete any operation requested. 
The Retry Attempts 
value determines how many failed attempts to retry before giving up on the operation. 
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Weather Monitor Setup
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      The Weather Monitor functionality in CCD Commander will allow you to image even in questionable
weather conditions.  CCD Commander will monitor the output of a Cloud/Weather Sensor and,
depending on the conditions you specify, will pause the action list, park the mount, and/or close your
dome.  Then when the bad weather condition clears, CCD Commander will open your dome, return the
mount to the previous position, and resume the next action in your list.  This can allow imaging in every
small piece of clear sky! 
 The Pause Action When
 list tells CCD Commander under what conditions you want to pause.  You can select any of the
conditions listed, but it is strongly suggested to enable all of them.  The allowable selections change
depending on the Cloud/Weather Sensor you have.  The images above show the different options
available for the different Cloud/Weather Sensors CCD Commander supports. 
 The Close Roof/Dome When list tells CCD Commander under what condition you want to close the
dome.  Again, you can select any of the conditions - however some of the selections are disabled when
Roof/Dome will close autonomously via the Emergency Contact Closure
  check box is enabled. 
 The Roof/Dome will close autonomously via the Emergency Contact Closure
 check box must be checked if you have connected your Cloud/Weather Sensor directly to your Dome
Controller.  When the Cloud/Weather sensor detects severe weather, it will send a signal directly to the
Dome Controller to close the dome.  CCD Commander does not and should not attempt to close the
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dome under this condition.  Thus when this option is checked, the conditions under which the
Cloud/Weather sensor activates its Emergency Contact are not enabled in CCD Commander to close
the dome.  However, CCD Commander will still make note of this event so that it knows to open the
roof/dome when the weather clears. 
 The Park Mount when Pausing Action
 check box tells CCD Commander to force the mount to a park position while the pause is in effect. 
When the pause is complete, CCD Commander will slew the telescope back to the original coordinates. 
 The Park Mount before Closing Roof
 check box has moved to the Dome/Roof setup tab.  
 Specify the frequency to query the cloud sensor using the Query Sensor every
 entry.  A value of 1 minute seems to work well, but you can experiment for the best value with your
configuration. 
 When a "good" condition occurs after the action has paused, CCD Commander times how long the
"good" condition has remained.  Use the Before resuming action, sensor must read clear for
 setting to tell CCD Commander how long to wait before resuming your action list. 
 Normally, when the action list is paused due to the Weather Monitor the current executing action will
stop and not resume.  When the "good" conditions return, the next action in the list will begin executing. 
Therefore when using the Weather Monitor function it may be important to not run any excessively long
single actions since it could be stopped mid-execution.  Instead spread out your tasks into multiple
actions.  When Repeat last action after resuming is checked the action that was in-process when the
action list was paused will be repeated.  (Be aware that this could lead to more images from a Take
Images
 action - for example.) 
 The Enable Weather Monitor Scripts
 allows for custom scripts for each weather event to be setup.  CCD Commander will execute the
specified script after each of the three possible weather events: Action List Paused, Dome Closed, Good
Condition Detected. 
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E-Mail Alerts Setup

  E-Mail Alerts are a very useful way to allow CCD Commander to notify you of an event when you are
not able to monitor the program directly.  The e-mail message CCD Commander sends is simple enough
to be sent to your cell phone (if you have a Text Messaging cell phone with an e-mail address - check
with your service provider). 
 Setting up the E-Mail Alerts in CCD Commander is similar to setting up any e-mail client.  CCD
Commander uses the Simple Mail Transport Protocol (SMTP) to send e-mail messages. 
 SMTP Server Setup: 
The SMTP Server Name or IP Address
 should be provided to you by your Internet Service Provider (ISP).  If you do not have this information
available, you should be able to get it with a simple request to your ISP's support department. 
 The Port #
 will almost always be 25.  Unless your ISP specifically tells you to use another number, you should not
need to change this value. 
 The Use SMTP Authentication should only be checked if your ISP specifically requires a user name and
password to send Outgoing
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 mail.  Usually this again is not required, but your ISP will let you know if it is.  You can also try sending
the test message with this disabled to see if SMTP Authentication is required. 
 Username and Password
 are the authentication credentials provided to you by your ISP.  CCD Commander will send these to the
ISP as part of the SMTP process. 
 E-Mail Addresses: 
The E-Mail Return Address
 can be anything, but should be a valid e-mail account.  If the SMTP process generates any errors as part
of sending the message (bad addresses, mailbox full, etc.) the error message will be sent to the return
address.  
 The E-Mail "To" Addresses list can be any number of e-mail addresses you want the alerts sent to. 
CCD Commander will copy each address in the list with the alert e-mail.  Be sure to enter at least one
address into the list via the Add button.  You can remove e-mail addresses by first clicking the address in
the list and then pushing the Remove
 button. 
 Send Test E-Mail will test the entire SMTP process to the Selected Address in the "To" address list. 
You must select (highlight) an address before pushing the Send Test E-Mail 
button.  CCD Commander will initiate the SMTP process and send a small e-mail to the selected
address and then notify you of success or failure.  Check your e-mail account for the test message. 
 Send E-Mail Alert When: 
This section defines the events that CCD Commander will send e-mails for.  Check each event that you
wish to be notified of.  When any event occurs, CCD Commander will send an e-mail to everyone in the
"To" address list and then continue standard execution. 
 E-Mail Script: 
If desired, CCD Commander can run a script any time it will send an e-mail alert.  The script will be
passed two arguments - the first is the subject of the e-mail alert, the second is the text of the e-mail alert.
This allows the data to be delivered in many different methods. 
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Focuser Options

  Enable Filter Offsets
 will turn on the filter offset function in CCD Commander.  When the filter offset function is enabled,
CCD Commander will automatically move your focuser the specified offset whenever the filter changes
positions. 
 Every filter you've defined in the Control/Device
 tab will be listed here.  To change the offset for a filter, double click the filter in the list. 
 Polarity of the offsets is dependant on the specific hardware in use.  If CCD Commander moves the
focuser the wrong direction, try reversing the offset polarities. 
 Measure average HFD after focus run 
is enabled only when FocusMax is the selected focus tool.  At the end of a focus run, when this is
enabled CCD Commander will take 5 additional exposures to measure the average HFD for reporting in
the CCD Commander log file.  If this is disabled, CCD Commander will report the HFD from the focus
routine.  The average HFD can be useful in under-sampled, or poor seeing conditions to give a better
representation of the focus achieved. 
 Retry Focus Run on Failure will cause CCD Commander to retry the focus run Number of Retries
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 times when the focus run fails. 
 Focus Time Out 
defines the maximum amount a time a focus run can take.  If this time is exceeded CCD Commander will
abort the focus run and retry (if retry is enabled). 
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Program Errors

  When CCD Commander encounters an error it cannot recover from, it will attempt to park the mount
and close the dome if these functions (Park Mount on Error and Close Dome on Error
) are checked. 
 The Enable Software Watchdog
 enables a separate program that runs in a separate process than the main CCD Commander process. 
CCD Commander communicates with the watchdog program on a periodic basis.  If something causes
CCD Commander to stop functioning - where it no longer reports to the watchdog program, then the
watchdog program will attempt to close the dome/roof and park the mount.  This is to try and prevent a
catastrophic problem caused by CCD Commander crashing or freezing.  However, as this is still a
software program running on the PC it is not immune from system wide PC crashes or freezing.  The
watchdog is an added layer of protection when using CCD Commander completely remote.  In
semi-remote configurations, the watchdog is normally not needed. 

Page 29



Action Setup

  From the main CCD Commander window you can access all the functions of CCD Commander.  
 There are at least two "tabs" on the main window.  
 The first tab is always the Main Action Setup
 tab.  This is where the you can create, view, and edit the primary action list. 
 All of the necessary controls are located in both the menus and the tool bar at the top of the window. 
 Relevant Menus: 
File Menu 
This menu contains all of the functions necessary to manage your action lists.  
 New
 will clear the Action List for a fresh session. 
 Open
 will open a previously saved Action List.  CCD Commander can open an action list created by any
previous version of the software. 
 Save will save the current Action List.  The Save
 menu item may not be enabled if you have never saved the current Action List. 
 Save As will save the current Action List to a new file.  You can use Save As
  for the initial save operation or to save the current Action List to a new file name. 
 Import Target List
 will open the Import Utility.  See here for more information. 
 Exit
 will close CCD Commander. 
 Edit Menu 
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This menu contains all of the functions necessary to edit and manipulate the action list. The Edit Menu
 is also available by right clicking the mouse on the Action List. 
 Copy Action 
will copy the selected actions to the Windows Clipboard.  You can then paste actions to a Sub-Action
List or another Action List in another instance of CCD Commander.  The data will be maintained in the
Windows Clipboard until you do another Copy or Cut from CCD Commander or any other application. 
 Cut Action 
will cut the selected actions to the Windows Clipboard.  This is the same as doing a Copy followed by a
Delete. 
 Paste Action
 will paste the current actions from the Windows Clipboard into the Action List.  The pasted actions will
appear immediately below the current selected action.  If there are no actions available in the Windows
Clipboard, this menu item will be disabled. 
 Delete Action 
will delete the selected actions in the Action List. 
 Move Action Up 
will move the selected actions in the Action List up one position. 
 Move Action Down 
will move the selected actions in the Action List down one position. 
 Check Selected will check the selected actions in the Action List.  See Use Check Boxes 
below for more information. 
 Uncheck Selected will un-check the selected actions in the Action List.  See Use Check Boxes 
below for more information. 
 Check All will check all the actions in the Action List (and any Sub-Action Lists).  See Use Check
Boxes 
below for more information. 
 Uncheck All will un-check all the actions in the Action List (and any Sub-Action Lists).  See Use
Check Boxes
 below for more information. 
 Use Check Boxes
 enables the check boxes in the Action Lists.  The check boxes allow individual actions to be enabled
(checked) or disabled (un-checked) from the action list.  This is a convenient method for editing your
Action List without actually removing any actions from your list.  When this function is enabled, the prior
four menu items (and tool bar icons) will be enabled. 
 Jump to Running Action 
will be enabled after a running action list containing sub-action lists has been modified.  Normally CCD
Commander keeps the visible sub-action lists in sync with the currently running action.  However, after
closing, adding, or modifying sub-action lists this will not be the case.  Select this menu option to re-sync
the GUI with the currently running action. 
 Actions Menu 
This menu contains all of the actions available in CCD Commander.  See the Actions
 book in the Table Of Contents for full details on each of the actions. 
 Run Menu 
This menu contains all of the functions necessary to run the action list. 
 Start will start running your action list.  When Use Check Boxes in the Edit Menu is un-checked,
Start will execute all of the actions in the list.  When Use Check Boxes is checked, Start will execute only
those actions that have a check mark.  Once the action list is running, Pause and Stop will become
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enabled.  When execution begins, CCD Commander will automatically switch to the Status tab and the
red running 
light will change to green and blink to show that the action is executing. 
 Pause  will pause a running action list until Start is selected again.  Pause only pauses the execution of
the action list in CCD Commander.  All the external programs and hardware will continue to operate. 
CAUTION: 
 The telescope mount will continue to track while CCD Commander is paused.  CCD Commander will
not be monitoring the telescope position or the Cloud Monitor.  Be sure to use the pause function
sparingly. 
 Stop  will stop (abort) a running action list.  This function will also stop any activity in the external
programs (slews, image exposures, autoguiding), but will NOT 
change the mount tracking.  Be sure to park the mount when complete. 
 NOTE for GEMs:  When you start the action, one of the first things CCD Commander will do is
connect to your mount though TheSky.  CCD Commander will try to determine what side of the meridian
your telescope is positioned on.  If your telescope is in the region of sky accessible from both sides of the
mount, CCD Commander will force your telescope to which ever side the telescope is closer to and then
move back to the coordinates you started at.  This is to ensure CCD Commander knows the correct side
of the meridian your telescope is on.  You can disable this function in the CCD Commander Setup
window.  When disabled, CCD Commander will prompt you to state which side of the mount the
telescope is on. 
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Status Tab

  While the Action List is being executed, CCD Commander will add to the Status display to inform you
of the current status.  This data remains available after the action is complete.  The current action that is
being executed is also shown at the top of the tab. 
 When you start running the action list a second time, the Status display will clear and start again. 
 The information displayed in the Status box is also written to your hard drive in the "Logs" directory
below the CCD Commander installation directory.  The log file is a simple text file and can be viewed in
any text editor or word processor.  The name of the log file is the date and time that the Action List was
run. 
 Relevant Menus: 
Run Menu 
This menu contains all of the functions necessary to run the action list. 
 Start will start running your action list.  When Use Check Boxes in the Edit Menu is un-checked,
Start will execute all of the actions in the list.  When Use Check Boxes is checked, Start will execute only
those actions that have a check mark.  Once the action list is running, Pause and Stop will become
enabled.  When execution begins, CCD Commander will automatically switch to the Status tab and the
red running 
light will change to green and blink to show that the action is executing. 
 Pause  will pause a running action list until Start is selected again.  Pause only pauses the execution of
the action list in CCD Commander.  All the external programs and hardware will continue to operate. 
CAUTION: 
 The telescope mount will continue to track while CCD Commander is paused.  CCD Commander will
not be monitoring the telescope position or the Cloud Monitor.  Be sure to use the pause function
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sparingly. 
 Stop  will stop (abort) a running action list.  This function will also stop any activity in the external
programs (slews, image exposures, autoguiding), but will NOT 
change the mount tracking.  Be sure to park the mount when complete. 
 NOTE for GEMs:  When you start the action, one of the first things CCD Commander will do is
connect to your mount though TheSky.  CCD Commander will try to determine what side of the meridian
your telescope is positioned on.  If your telescope is in the region of sky accessible from both sides of the
mount, CCD Commander will force your telescope to which ever side the telescope is closer to and then
move back to the coordinates you started at.  This is to ensure CCD Commander knows the correct side
of the meridian your telescope is on.  You can disable this function in the CCD Commander Setup
window.  When disabled, CCD Commander will prompt you to state which side of the mount the
telescope is on. 
 Graphs Menu 
Enable Temperature Recording 
will enable or disable recording of the temperature and the graph function.  Only when this is enabled,
can you view the CCD Temperature Graph. 
 CCD Temperature Plot shows a window of the CCD temperature plotted over time.  See the CCD
Temperature Graph
 page for more information. 
 Enable Guider Error Recording 
will enable or disable recording of the guide error.  Disabling this can possibly increase your guider
performance.  Disabling this will also disable the Autoguider Error Graph. 
 CCD Guide Error Plot shows a window of the autoguider error plotted over time.  See the Autoguider
Error Graph
 page for more information. 
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Move to RA & Dec Action

  The Move to RA/Declination Action
 will simply move the telescope to the coordinates entered.  These coordinates can be either for the
Epoch of the date the action is performed (JNow) or for the Epoch at January 1, 2000 (J2000).  When
you select J2000 coordinates, CCD Commander will automatically precess the coordinates to JNow
when the action is performed.  If you want to match coordinates over many days or months using the
same action, use J2000 coordinates.  Only whole number values are allowed in each field. 
 The Get RA/Dec from TheSky
 button will pull the coordinates from the currently selected object in TheSky.  When you click this button
CCD Commander will check to see what is selected in TheSky.  If there are multiple objects that could
be selected, CCD Commander will display the following window to allow you to select your desired
target from the list: 

 If your desired object is not show, click closer to the object in TheSky and push the 
Refresh button. 
 The 
Get RA/Dec from Current Telescope Position will query the location the telescope is pointing to and
enter the values into the window.  This is useful if you have a difficult framing of the object and have
framed it properly before creating your action list. 
 You can also enter the targets name in the Object Name
 box.  This box can be used to name your target anything you desire.  This name will show up in your
action list instead of the RA and Declination coordinates. 
 If you enter a real object name in the Object Name box, you can get the coordinates for this object from
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TheSky by clicking the 
Find Object in TheSky button.  If the object is found, the coordinates will be entered automatically for
you.  If the object is not found, the coordinates will be set to 0. 
 The Recompute Object Coordinates before Slew checkbox tell CCD Commander to find the object
again in TheSky and get the updated coordinates.  This is very useful for fast moving objects.  If you
enter an invalid name in the 
Object Name box, CCD Commander will warn you with a beep when you push the OK button.  This
checkbox is disabled when J2000 coordinates are selected since the JNow coordinates will automatically
be recomputed before the Slew.  Recomputing the Object coordinates is only valid when using JNow
coordinates. 
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Rotate with Instrument
Rotator Action

  This action will rotate the instrument rotator. 
 The 
New Rotation Angle specifies the new Position Angle for the camera.  The specified angle is not the
rotator angle, but the actual north angle of the camera.  CCD Commander will automatically compute the
rotator angle and move the rotator the proper amount.  Additionally, if the guider moves with the rotator,
CCD Commander will recompute the guider coefficients to ensure guiding can continue after rotation. 
 The Get Position Angle from TheSky6 FOVI
 button will automatically query the Position Angle from the active FOVI in TheSky6.  This allows you to
properly frame your target and select a guide star using the FOVI in TheSky6.  CCD Commander will
then enter the proper Position Angle for you, allowing a simple method of generating your action list. 
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Plate Solve and Sync Action

  This action will take an image (using the imaging detector) and perform a Plate Solve.  Next CCD
Commander will either Sync the mount, or compute an offset of the current position.  This is extremely
useful for mounts that do not have superb pointing accuracy.  Please note that the pointing accuracy must
be good enough for the Plate Solve to succeed.  Finally, if selected, CCD Commander will slew to the
original coordinates. 
 The Exposure Time, Delay Before Exp., Bin, and Filter
 define the values for the exposure that will be taken.   
 The Full Frame, Half Frame, and Quarter Frame selections define the area of the imager detector to use.
For wide field images, the Plate Solve can fail when the image covers to large an area of sky.  In this
case, Quarter Frame or Half Frame can be used.  For narrow field images, 
Full Frame would probably work best to give the most number of cataloged stars in the image. 
 Sync Mount
 tells CCD Commander to send a Sync command to your mount to correct where your mount thinks it is
positioned.  This can be undesirable for T-Point users, as the Sync command can corrupt the model. 
 Offset Position tells CCD Commander to compute the offset between where the mount thinks it is
pointing and the Image Link results.  Then on future slews, CCD Commander will apply this offset to
correct for the mount pointing error.  This option is excellent for T-Point users as it will not affect the
model. 
 Slew to Original Location after Solve
 will slew the mount to the coordinates it should have been at before the Plate Solve - using either the
updated mount position from the Sync, or the offset computed.  This gives you optimal pointing
accuracy. 
 Normally when the Plate Solve fails, CCD Commander will simply go the next action in the list.  Abort
List/Sub-List if Solve Fails
 will abort the entire Action List or Sub-Action List that the Plate Solve action resides in.  If the Plate
Solve action is in a Sub-List, execution will resume on the next action in the parent list.  This can allow
you to have some shut-down actions (close dome, park mount, etc.) in the parent action that will be
executed when a Plate Solve fails. 
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 Retry Plate Solve on Failure will cause 
CCD Commander to retry the plate solve exposure and solve if the first attempt fails. 
 Slew Mount if First Solve Fails...
 will slew the mount prior to retrying the plate solve exposure.  The slew will move the telescope in a
direction toward the zenith.  If the slew amount is large enough to move past the zenith and you are using
a GEM, CCD Commander will flip the mount as part of this slew.  This function can be used in a number
of different ways.  
 One example is a rudimentary cloud monitoring system.  If the first plate solve fails (presumably due to
clouds obstructing the view), the slew size can be set large enough to point toward another part of the
sky.  When the second solve succeeds it implies that the entire sky is not cloudy and the Action List can
continue. 
 Another use for this function is if you are plate solving on a star poor region of the sky, a small slew
could help bring more stars into the field-of-view so that the second plate solve exposure can succeed. 
 There are likely other uses for this function as well. 
 Skip to Next Target if Second Solve Succeeds
 will cause CCD Commander to skip all the actions until the next Move To action.  This is specifically
used in the rudimentary cloud monitoring system mentioned above, but there may be other uses as well. 
 Image Save Location 
The Use Global Image Save Location checkbox tells CCD Commander to use the path specified in the 
File Options setup window.  When the checkbox is checked, the Global path is shown in the 
Image Save Location box. 
 When Use Global Image Save Location is not checked, the "..." button is enabled.  You can then specify
a different save location for this action only.  Click the "
..." button to select the folder you want to use. 
 Filename Prefix
 defines the start of the file name given to the downloaded images.  CCD Commander will append a
counter value to uniquely identify each file name.  CCDSoft may also append further information about
the target to the file name.  
 The "..." button to the right of the Filename Prefix text box opens up the File Name Builder window
which helps with creating automatic file name tokens.  Visit the File Name Builder
 help page for more information. 
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Focus Action

  This action will run a focusing routine using the filter selected.  The Focus routine will execute using
whatever parameters you have configured in the focusing tool.  Be sure that the focusing tool executes
how you want using the parameters set. 
 The view of this window can change depending on the focusing tool selected.  The default view is
above. 
  For 
FocusMax, the window will change to this: 

  Exposure Time 
sets the initial exposure time FocusMax will use for the focus routine. 
 Specify Focus Star Position
 allows you to pick the star location for focusing.  This is useful if you do not slew to a focus star and
want to use the target field-of-view to focus.  Normally FocusMax chooses the brightest star in the field,
but sometimes this can be the core of a galaxy or a star that may be too bright for focusing.  Using this
function allows you to specify the coordinates of the star you want to use. 
 Star X pos and Star Y pos
 specify the coordinates of the star you want to use. 
 Get Position will pull the position of the star last used by FocusMax for the focus routine.  You can use
the FocusMax Select focus function to pick the star you want (if you are also using MaxIm/DL).  You do
not have to use the Get Position
 button - simply entering the star coordinates works just as well. 
  For CCSoft @Focus
, the window will change to this: 

  Exposure Time
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 specifies the length of the focus exposure you want to use for the @Focus run. 
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Take Image Action

  The Take Image Action window contains all the parameters for taking unattended guided or unguided
images.  The window is broken into five sections: Imager Information, Autoguider Information, Dither
Information, Image Save Location, and Plate Solve Exposure
 Information.  You can click on the image above to go directly to that section in this page. 
 Imager Information 
Here you define all the parameters for the imaging detector.  The parameters here are similar to those
defined in the camera control program.  Some specific notes: 
 Custom Size
 frame size will allow you to specify the exact size of the image you want.  CCD Commander will center
as best is possible the custom frame size on the middle of the detector. 
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 Calibrate Images
 will run a full calibration on your images as they are downloaded.  You must setup the image calibration
function in the camera control program to use the proper calibration frames.  CCD Commander will save
both the RAW and REDUCED files. 
  Autoguider Information 
Here you define the parameters for autoguiding while the imaging detector is being exposed.  
Autoguider Enabled enables and disables the autoguiding function.  If you are talking a Dark, Bias, or
Flat-field image, you would typically disable autoguiding. 
 The Exposure Time, Guide Star X pos, and Guide Star Y pos entries are only active when the 
Automatic Guide Exposure
 function is disabled.  If you want to manually choose your guide star, enter the information in these
fields. 
 Max Error to Start defines what the maximum allowable error (in pixels) of the guide star can be before
the imager begins its exposure.  The autoguider will run until the guide error is less then this amount, or
after 
Max Guide Cycles to Wait  tries.  If the autoguider is unable to achieve a value less then this, the action
will be stopped and CCD Commander will proceed to the next action in the list. 
 Guider Init Delay
 specifies the number of seconds to wait before checking the guide error.  If you know the guider takes a
specific time before it pulls in the error you can set that time here.  CCD Commander will then check the
guide error after this time has elapsed. 
 Enabling the Autoguider also enables the Dither Information
 parameters. 
 Unguided Dither is enabled when Autoguider Enabled is unchecked.  Checking Unguided Dither will
enable the Dither Information parameters.  Unguided Dither will slew the mount by the specified Dither
Step
 to dither your exposures. 
 Dither Information 
Dither Frequency defines how often the guide star is dithered during the imager exposure.  A 
Dither Frequency of 1 will move the guide star after every exposure of the imaging detector.  A value of
2 will dither after every 2 exposures of the imaging detector.  This can be useful when taking many short
imager exposures as the dither process can take some time to complete. 
 Dither Step defines the size of the dither movement between images.  CCD Commander will always
move this amount from one image to the next.  Ensure that the Dither Step
 size is large enough to move at least one pixel on your imaging detector. 
 Maximum Dither defines the total size of the "dither box" around the guide star or initial coordinates. 
The guide star will never be more than the 
Maximum Dither number of pixels or arcseconds from the where it started. 
 X Axis Dither and Y Axis Dither
 can be used to selectively enable or disable the X and Y axis from the dithering process. 
 Maintain Dither Position With Filter Change
 tells CCD Commander to continue the dither position and direction even after a filter change.  Normally
CCD Commander will attempt to re-use the same guide star and same dither position/direction when you
image at the same coordinates with the same filter.  On a filter change, CCD Commander can also keep
the dithering coherent.  This function is useful primarily when taking one image per filter and repeating the
filter set like this: RGBRGBRGBRGB.  With this kind of image sequence, the dither position will adjust
for every image in the set such that the like-kind sub-exposures are all dithered.  When imaging a single
filter at a time, like RRRGGGBBB, it makes sense to reset the dither position with each filter change
because it only matters that sub-exposures are dithered among each other.  Dithering between filters
would not be necessary for this imaging plan. 
 CCD Commander will always dither in a deterministic manner.  This will ensure that every image is
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always offset the same amount from the previous image and that any imager defects are always at a
different location in your image set.  In addition, the pattern CCD Commander follows ensures that the
guide star will move a minimal amount between exposures, maximizing your imaging time. 
 Below is a plot showing how the guide star will move for a setup where the Dither Step is set to 1 and
the Maximum Dither
 is set to 2.  CCD Commander starts with the guide star at the (0,0) position and moves a maximum of 1
pixel between each exposure.  As soon as the dither location reaches the (2,2) coordinate, CCD
Commander will retrace the dither path back to (0,0).  

Image Save Location 
The Use Global Image Save Location checkbox tells CCD Commander to use the path specified in the 
File Options setup window.  When the checkbox is checked, the Global path is shown in the 
Image Save Location box. 
 When Use Global Image Save Location is not checked, the "..." button is enabled.  You can then specify
a different save location for this action only.  Click the "
..." button to select the folder you want to use. 
 Filename Prefix
 defines the start of the file name given to the downloaded images.  CCD Commander will append a
counter value to uniquely identify each file name.  CCDSoft may also append further information about
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the target to the file name.  
 The "..." button to the right of the Filename Prefix text box opens up the File Name Builder window
which helps with creating automatic file name tokens.  Visit the File Name Builder
 help page for more information. 
 Plate Solve and Sync after Meridian Flip 
This check box will tell CCD Commander that after a meridian flip it should take an image, preform a
Plate Solve, and then sync the mount to the Image Link coordinates.  This function is useful for mounts
that cannot exactly center an object after the meridian flip.  Since it is not necessarily known when the
meridian flip will occur, it is useful to enable this function for every imager action (assuming this function is
necessary).  If the Plate Solve fails, CCD Commander will abort this action and move on to the next
action in the list. 
 See the Plate Solve action for full details on each of these parameters.  Note there is no 
Slew to Original Location after Solve parameter here.  This function is always enabled for a Plate Solve
after Meridian Flip. 
 The Perform two Plate Solves after Meridian Flip
 option causes CCD Commander to repeat the plate solve.  This is very useful if your mount has a
significant amount of backlash after a meridian flip.  If the first plate solve cannot get the target centered
properly, the second one should be able to. 
 Checking Center AO When Complete 
will set the AO deflection to the exact center position.  This helps with mistaken image offsets during
Plate Solve actions. 
 Checking Sync to Current RA/Dec When Complete will cause CCD Commander to issue a Sync
command to the mount for the coordinates from the last Move To
 action. 
 Checking Rotate 180 degrees after Meridian Flip
 will cause the rotator to compensate for the meridian flip. 
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Wait for Altitude Action

  This action will wait for the object entered to reach the specified altitude.  CCD Commander can
automatically compute the altitude of the Sun, Moon, or any deep space object using its celestial
coordinates.  For deep space objects, the coordinates are for the Epoch of the date the action is
performed.  Only whole number values are allowed in each field. 
 When you select Sun or Moon in the Object Type box, the Object Coordinates and Object Name are
disabled.  Only when Other
 is selected are these fields available. 
 The Get RA/Dec from TheSky
 button will pull the coordinates from the currently selected object in TheSky.  When you click this button
CCD Commander will check to see what is selected in TheSky.  If there are multiple objects that could
be selected, CCD Commander will display the following window to allow you to select your desired
target from the list: 

 If your desired object is not show, click closer to the object in TheSky and push the 
Refresh button. 
 Alternately, you can enter an object name in the Object Name field.  When you click the 
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Find Object in TheSky, CCD Commander will query the object's location from TheSky and
automatically fill in the RA and Declination values for the object.  If the object is not found, CCD
Commander will enter 0 in each of the RA and Declination fields. 
 Wait until object is at altitude 
specifies the altitude you want to wait until.  
 Rising
 selects that CCD Commander should wait for the target to be higher than the specified altitude.  Note
that the altitude you enter might never be reached by the object in question.  When this occurs, this action
will complete when the object crosses the meridian.  If you want to simply wait until the object crosses
the meridian, you can enter 90 degrees for the altitude. 
 Setting
 selects that CCD Commander should wait for the target to be lower than the specified altitude. 
 NOTE for GEMs:  CCD Commander does not monitor the position of the mount during the Wait
action.  Therefore, it is best that your mount be in the parked position and not tracking if the Wait action
will run for a significant period of time.  If your mount is tracking during the Wait action, you must ensure
your mount is positioned such that it will not enter the safety limits during the Wait
 action. 
 The Compute Approximate Wait Time
 button will run CCD Commander's altitude calculation routines and report the approximate time your
selected object will reach the altitude you have set. 
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Wait for Time Action

   Absolute: 
When Absolute 
 is selected, this action will wait until the specified time.  The time entered is in normal 24 hour format. 
 The function will wait based on a 24 hour window from noon to noon.  If the entered time is before the
current time based on this noon to noon window CCD Commander will assume the time has passed and
will not wait at all.  For example, if you enter a time of 13:00 and it is 23:00 when the action runs, it will
not wait at all.  If you enter a time of 11:00, the action will wait until 11:00 except if the action runs when
the current time is after 11:00 but before 12:00. 
 Relative: 
When Relative
 is selected, this action will wait for the specified number of hours/minutes/seconds.  The longest wait you
can enter is 24 hours 59 minutes 59 seconds. 
 You can use the up and down arrow buttons to change the values as well as entering values in directly. 
 NOTE for GEMs:  CCD Commander does not monitor the position of the mount during the Wait
action.  Therefore, it is best that your mount be in the parked position and not tracking if the Wait action
will run for a significant period of time.  If your mount is tracking during the Wait action, you must ensure
your mount is positioned such that it will not enter the safety limits during the Wait 
action. 
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Skip Ahead at Time Action

  This action provides a powerful tool in managing your action list.  At the time specified, CCD
Commander will skip ahead in your action list to the point where the Skip Ahead
 action is. 
 The most obvious use of this action is to automatically stop imaging and run a shutdown action at dawn. 
Then you can specify as long an action list as you want and the Skip Ahead 
action will stop the other actions before the sky brightens or the guide star is lost - preventing unneeded
exposures and chasing a fading guide star.  
 Another possibly use is to ensure that you start imaging an event at the proper time.  You can setup
actions before and after the event to fully use the nights session.  The Skip Ahead 
action will force CCD Commander to execute the actions associated with the event at the proper time,
regardless of what was in the action list. 
 All that is needed is to enter the time you want CCD Commander to skip ahead at. 
 When you run an action list, CCD Commander will automatically search the action list (and any
Sub-Action Lists) for all the Skip Ahead actions.  The times are sorted so that the earliest Skip Ahead
action will execute first.  This means that if you specify Skip Ahead
 actions out of chronological order, you might have some actions that will never execute. 
 Enabling the Soft Skip option will cause CCD Commander to not skip at exactly the time requested 
if an image is in process.  CCD Commander will wait for the image to complete prior to executing the
skip. 
 Note: The Automatic Flat action contains a built in skip when you select dusk or dawn flats.  The skip
time is either sun set (for dusk flats) or the start of twilight (for dawn flats).  You can find out what time
these occur in the Automatic Flat action window.  These times change every day, so be aware when
using Skip Ahead actions and Automatic Flat
 actions (for dusk or dawn flats). 
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Skip Ahead when Object
reaches Altitude Action

  Similar to the Skip Ahead at Time Action
, this action will cause CCD Commander to skip ahead to the point that this action is in your list when
your specified target reaches the altitude you specify. 
 This action performs identically to the Skip Ahead at Time Action
.  When you start running the action list, CCD Commander performs the calculations necessary to
determine at what time the specified object will reach the desired altitude (either rising or setting).  Then
when the time is reached, CCD Commander will execute the skip. 
 CCD Commander can automatically compute the altitude of the Sun, Moon, or any deep space object
using its celestial coordinates.  For deep space objects, the coordinates are for the Epoch of the date the
action is performed.  Only whole number values are allowed in each field. 
 When you select Sun or Moon in the Object Type box, the Object Coordinates and Object Name are
disabled.  Only when Other
 is selected are these fields available. 
 The Get RA/Dec from TheSky
 button will pull the coordinates from the currently selected object in TheSky.  When you click this button
CCD Commander will check to see what is selected in TheSky.  If there are multiple objects that could
be selected, CCD Commander will display the following window to allow you to select your desired
target from the list: 
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 If your desired object is not show, click closer to the object in TheSky and push the 
Refresh button. 
 Alternately, you can enter an object name in the Object Name field.  When you click the 
Find Object in TheSky, CCD Commander will query the object's location from TheSky and
automatically fill in the RA and Declination values for the object.  If the object is not found, CCD
Commander will enter 0 in each of the RA and Declination fields. 
 Skip when object is at altitude 
specifies the altitude you want to skip at.  
 Rising
 selects that CCD Commander should wait for the target to be higher than the specified altitude.  Note
that the altitude you enter might never be reached by the object in question.  When this occurs, this CCD
Commander will skip ahead when the object crosses the meridian.  If you want to simply skip when the
object crosses the meridian, you can enter 90 degrees for the altitude. 
 Setting
 selects that CCD Commander should skip when the target is lower than the specified altitude.  If the
target can never go above the specified altitude, the skip will activate as soon as the target crosses the
meridian. 
 The Compute Approximate Skip Time
 button will run CCD Commander's altitude calculation routines and report the approximate time your
selected object will reach the altitude you have set. 
 Enabling the Soft Skip option will cause CCD Commander to not skip at exactly the time requested 
if an image is in process.  CCD Commander will wait for the image to complete prior to executing the
skip. 
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Skip Ahead when Object
reaches Hour Angle Action

  Similar to the Skip Ahead at Altitude Action
, this action will cause CCD Commander to skip ahead to the point that this action is in your list when
your specified target reaches the hour angle you specify. 
 When you start running the action list, CCD Commander performs the calculations necessary to
determine at what time the specified object will reach the desired hour angle.  Then when the time is
reached, CCD Commander will execute the skip. 
 The Get RA from TheSky
 button will pull the coordinates from the currently selected object in TheSky.  When you click this button
CCD Commander will check to see what is selected in TheSky.  If there are multiple objects that could
be selected, CCD Commander will display the following window to allow you to select your desired
target from the list: 

 If your desired object is not show, click closer to the object in TheSky and push the 
Refresh button. 
 Alternately, you can enter an object name in the Object Name field.  When you click the 
Find Object in TheSky, CCD Commander will query the object's location from TheSky and
automatically fill in the RA values for the object.  If the object is not found, CCD Commander will enter 0
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in each of the RA fields. 
 Skip when object is at Hour Angle 
specifies the hour angle you want to skip at.  
 The Compute Approximate Skip Time
 button will run CCD Commander's altitude calculation routines and report the approximate time your
selected object will reach the altitude you have set. 
 Enabling the Soft Skip option will cause CCD Commander to not skip at exactly the time requested 
if an image is in process.  CCD Commander will wait for the image to complete prior to executing the
skip. 
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Automatic Flat Action

  The 
Automatic Flat action will take automatic flats at Dusk, Dawn, or using your own flat screen.  CCD
Commander will automatically determine the optimum exposure time to achieve your desired average
ADU.  In addition, CCD Commander can continuously adjust the exposure time to maintain as constant
an average ADU as possible - especially useful for Dusk and Dawn flats. 
 Flat Information: 
Minimum Exposure Time and Maximum Exposure Time
 are used to bound the exposure. 
 Minimum Average ADU Value and Maximum Average ADU Value
 is range of average ADU values that indicate when the exposure time is sufficient.  Once the average
ADU value is within this range, CCD Commander will begin exposing your flats.  CCD Commander will
target half way between the minimum and maximum average value. 
 Number of Exposures is the quantity of flats you want for 
each filter. 
 The Exposure Setup Frame Size 
sets the size of the frame (centered in the middle of the detector) that CCD Commander should use when
it is trying to determine the exposure time at the beginning of the flat routine.  Setting this to half or quarter
frame can be very useful if you have a camera with a slow download.  This will speed up the exposure
setup time - giving you more time (especially useful at dusk or dawn) for your actual flats. 
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 The Flat Frame Size
 specifies the frame size for the actual flat field frames that will be saved. 
 If you don't want to save your flats, uncheck the Autosave Exposures
 checkbox.  Be aware that you will not get any saved flats if this is not checked. 
 Filename Prefix is the text that is used at the start of the filename.  CCD Commander will add text for
each filter that is used in the action before the Filename Prefix.  CCD Commander will add text for each
rotation that is used after the Filename Prefix
.  You can change this behavior by placing the Filter and Position Angle auto-naming tokens in the
filename prefix. 
 The "..." button at the end of the Filename Prefix text box will open up the File Name Builder
 window.  Click the link for more information. 
 The Take Matching Darks function will, at the end of the Automatic Flat function, take matching dark
frames for the exposures used for your flat frames.  You can specify how many darks per flat to
exposure via the Number of Darks per Flat
 parameter. 
 The number of matching darks could be quite large, especially when CCD Commander continuously
adjusts the flat exposure time during dusk or dawn flats.  Setting the Dark Exposure Time Tolerance 
to a number greater than 0 will reduce the total number of darks taken.  This is best illustrated with an
example.  Assume CCD Commander exposed a set of flats using these exposure times: 
3.7s, 3.9s, 4.1s, 4.3s, 5.9s, 6.5s, 7.0s, 7.6s, 8.6s, 9.7s, 10.3s, 11.9s, 13.0s, 15.7s, 19.0s 
If Dark Exposure Time Tolerance 
is set to 1 second, then CCD Commander will expose darks that are at least 1 second apart, starting
with the first exposure time.  So the darks exposed would be: 
3.7s, 5.9s, 7.0s, 8.6s, 9.7s, 11.9s, 13.0s, 15.7s, 19.0s 
Now if the Dark Exposure Time Tolerance
 were set a bit higher to 10 seconds, the following would be exposed: 
3.7s, 15.7s 
 The Dark Exposure Time Tolerance 
will need to be tuned to your sensor to give you the best set of darks that can be applied to your
detector. 
 Mount Information: 
If Park Mount is selected, CCD Commander will park the mount before executing the 
Automatic Flat action.  This is useful if you have a flat screen that your telescope can point at when it is in
the park position. 
 If Dusk Sky Flat is selected, CCD Commander will use its automatic dusk flat routine.  No matter what
it is doing when the sun sets, CCD Commander will automatically skip ahead in the action list to the
Automatic Flat action and begin executing at sun set.  Next, CCD Commander will slew the telescope
just east of the zenith - the optimum point in the sky for dusk flats.  CCD Commander then starts taking
images at the Minimum Exposure Time.  If the sky is too bright for the current filter, CCD Commander
will continue taking exposures until the sky is dark enough to reach the Average ADU Value.  CCD
Commander will keep the telescope pointed at the same Altitude and Azimuth location which will cause
any stars that may appear in the image to move through the frame - allowing a median combine to
remove the stars from the flats.  If the sky gets too dark to maintain the 
Maximum Exposure Time CCD Commander will stop taking flats.  
 You can specify where the sun should be when the Dusk Sky Flat begins.  When using narrowband
filters, it is sometimes useful to start flats even before the sun has fully set.  The default Sun Altitude for
Dusk Sky Flat is -0.83 degrees - this is the point at which the sun's disc is completely below the horizon. 
Set this number closer to 0 (or even positive) to start the Automatic Flat earlier in the evening.  A larger
negative number will start the Automatic Flat
  routine later in the evening. 
 Dawn Sky Flat acts very similar to Dusk Sky Flat.  Just like with Dusk Sky Flat, Dawn Sky Flat CCD
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Commander will automatically stop the current executing action and skip all of the actions until the
Automatic Flat action is reached when the sun reaches the specified altitude.  Next, the telescope will
slew to just west of the zenith - the optimum point in the sky for dawn flats.  CCD Commander then
starts taking images, except now if the sky is to dark for the current filter CCD Commander will continue
taking exposures until the sky is bright enough to reach the Average ADU Value.  Again CCD
Commander will keep the telescope at the same Altitude and Azimuth.  Finally if the sky gets too bright
to maintain the Minimum Exposure Time
 CCD Commander will stop taking flats. 
 The Sun Altitude for the Dawn Sky Flat is exactly like that for the Dusk Sky Flat
.  You can adjust this value to start the flat routine earlier (larger negative numbers) or later (numbers
closer to 0) in the morning. 
 When Dusk Sky Flat or Dawn Sky Flat is selected, the Compute Dusk/Dawn Start Time button
appears.  Clicking this executes CCD Commander's sun set or dawn twilight start algorithms and reports
the time at which the 
Automatic Flat action will begin. 
 The Slew To option causes new fields to appear on the screen where you can specify a specific altitude
and azimuth.  CCD Commander will slew to the specified Altitude and Azimuth and take your flats.  This
is useful if you have a flat screen mounted somewhere other than your telescope park position.  Just like
with the others, CCD Commander will maintain the Altitude and Azimuth position during the 
Automatic Flat action. 
 Finally the Do not connect to or move mount option will do just that.  CCD Commander will leave your
mount alone when executing the Automatic Flat
.  This can be useful if you are using a flat box and have set the telescope to a specific position already. 
 Rotations: 
This
 section defines all of the position angles you want your flats exposed at.  CCD Commander will try to
take all of the position angles requested for each filter, until the minimum or maximum exposure time is
reached.  It will move through the position angle list from the top to the bottom, taking flats for each
position angle before moving to the next filter.  The order of the position angles is not terribly important,
although it is probably prudent to order the angels to minimize the time that the rotator must spin. 
 Filters: 
This section defines all of the filters you want to use in the Automatic Flat action.  CCD Commander will
take as many flats as it can (given sky condition) for each filter.  It will move through the filter list from the
top to the bottom, taking all the flats for each filter before moving to the next.  If you are using Dusk Sky
Flat or Dawn Sky Flat, the order of the filters is very important.  Since the sky will be darkening during
the Dusk Sky Flats, you should order your filters from narrowest to widest - this allows the narrow filters
to be used when the sky is bright and the wider filters to be used when the sky is darker.  For 
Dawn Sky Flats, you should order your filters from widest to narrowest - this allows the wider filters to
be used when the sky is dark and the narrower filters to be used when the sky is brighter. 
 The Reverse Order button is useful when you've just setup Dusk Sky Flats and now are trying to setup
Dawn Sky Flats
.  Rather than having to manually reverse the filter order, pushing this button will reverse it for you. 
 CCD Commander will automatically determine the optimum exposure time to achieve an average ADU
value between the Minimum Average ADU Value and Maximum Average ADU Value before saving any
exposures.  During twilight flats (dusk or dawn) the sky is continuously darkening or brightening.  If the
exposure time is maintained over the flat set, the average ADU of the exposures will change.  When the
Continuously adjust exposure time to match ADU target. checkbox is checked, CCD Commander will
adjust all of the exposure times to try and achieve a target ADU mid-way between the Minimum Average
ADU Value and the 
Maximum Average ADU Value for every saved exposure.  This could result in a different exposure time
for every flat - so be sure to normalize the flats when combining. 
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 The Use Global Image Save Location checkbox enables you to specify a different path for your flat
images.  When this is uncheked, the "
..." button is enabled and you can select a different location to save these images. 
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Intelligent Temperature
Control Action

          The Enable Cooler and Disable Cooler selections tell CCD Commander what you what to do for
this entry in the action list.  When Enable Cooler is selected, the Intelligent Cooling or Simple Cooling
 sections are enabled.  These sections are described further below. 
 Disable Cooler will slowly warm the camera up and then turn off the camera's cooler. 
 The Fan On
 checkbox is used to enable or disable the camera's fan when the action is run.  Not all camera control
programs can control the camera's fan. 
 When the Use Intelligent Cooling checkbox is unchecked, the Simple Cooling section is shown.  In this
mode, when this action is reached CCD Commander will set the cooler to the temperature specified in
Temperature Set Point
 and then continue to the next action in the list.  If you want to wait for the temperature to stabilize you
will need to insert your own delay into the action list. 
 When the Use Intelligent Cooling checkbox is checked, the 
Intelligent Cooling section is shown.  In this mode CCD Commander performs a more complicated
routine to not only set the cooler to a temperature, but also monitor it until it stabilizes and attempt to set
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a lower temperature if possible. 
 The Desired Temperatures
 list contains all the temperatures that CCD Commander will attempt to set.  It will start at the warmest
temperature and after the cooler reaches the set temperature, it will go to the next temperature in the list. 
CCD Commander is able to set the coolest temperature possible at the time the action runs. 
 Maximum cooler power
 specifies the highest cooler power you want to operate at.  After CCD Commander sets a temperature
from the list it will wait for the cooler to reach the temperature.  When it has reached the temperature,
CCD Commander will wait for the temperature to stabilize.  Once it has stabilized, CCD Commander
checks the cooler power.  If it is greater then this value, CCD Commander backs off to the previously
achieved temperature. 
 Maximum time for temperature to stabilize specifies how long CCD Commander will wait for 
each temperature in the list to stabilize.  If the temperature has not stabilized after the set time, CCD
Commander backs off to the previously achieved temperature. 
 The two values under 
Temperature is stable when: specify the parameters CCD Commander uses to determine at temperature
setting is stable.  Even when the temperature is stable, there is some variation in both the temperature and
the cooler power.  These two values specify how much variation is acceptable to consider the
temperature stable.  Watch your cooler performance for a few minutes to determine the optimum values
for these parameters. 
 Note: 
If CCD Commander cannot achieve the minimum temperature in this list, it will leave the cooler at that
value and exit the action.  The next item in your action list will then execute.  So if you need to ensure the
cooler is stable after leaving this action, you must be certain the minimum temperature is achievable given
the parameters you set. 
 Automatic Dark Library: This action can be used (along with the Take Image action) to build a dark
library at multiple temperatures on a cloudy night.  Simply setup the Intelligent Temperature Control
(ITC) action with a single (achievable) temperature in the temperature list.  Follow this action with a Take
Image action for your dark frames.  Next use another ITC action to set the next lower temperature you
want, then another Take Image
 action.  You can continue this for as many temperatures as you need.  Be sure to start the session using
higher temperatures and set lower temperatures throughout the night. 
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Dome Control Action

  This action will perform a number of functions on your dome.  Simply select the function you want
performed for this action. 
 Note:
 Not all domes support all of these functions.  CCD Commander will attempt to perform the function
requested, but some functions may not be supported by all domes. 
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Weather Monitor Action

  This action will Enable and Disable the Weather Monitoring function in CCD Commander.  It may be
important to disable Weather Monitoring after the dome is closed so you can take dark/bias frames at
the end of a session.  If Weather Monitoring were left enabled, it would pause the Action List even
though the telescope is protected from the weather. 
 Special Note relating to Skip Ahead Action:  When a Skip Ahead action activates, when CCD
Commander is skipping over actions prior to the Skip Ahead, it will not skip a Weather Monitor Action. 
Instead the Weather Monitor Action will be executed.  This allows you to have a Skip Ahead 
action that terminates your session at dawn and then shuts down your system.  Without this functionality,
a cloudy condition would keep the Action List paused and the shutdown processes would never be run. 
 An example Action List using the Weather Monitor action and the 
Skip Ahead action is as shown here: 

 In the above Action List, I've created a number of Sub-Action Lists that represent some common tasks. 
At 06:00, CCD Commander will execute the Skip Ahead action and skip everything up to the location of
the Skip Ahead action.  The Weather Monitor action disabling the Weather Monitoring will be executed
immediately before the 
Skip Ahead action is reached. 
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 If the Weather Monitor action were located after the Skip Ahead action, then a cloudy condition would
pause the action list immediately after the 
Skip Ahead action was executed and the process would be stuck waiting for the skies to clear.  There is
no danger in this occurring since the Cloud Monitor function would park the scope and close the dome
as necessitated by the weather.  But you would loose out on time that could be spent doing other things
like taking Bias and Dark frames. 
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Run Program Action

  This action will run an external program (script or executable) that you specify.  Click the "
..." button to browse for the program you want to run.  Once you select the program, the full path name
will appear in the window. 
 Arguments for the program can be added in the Arguments 
text box.  Any number of arguments can be placed here. 
 The 
Wait for program to finish selection will, if checked, tell CCD Commander to wait for the completion of
the program before executing the next action.  If you do not check this box the program will run
concurrently with the following actions in CCD Commander. 
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Run Sub-Action List

   Clicking this action in the Actions menu will open a new Sub-Action
 tab on the main window.  This will allow you to run an entirely new action list within a single line on your
Main Action List.  Any number of Sub-Action Lists can be added - including Sub-Action Lists in a
Sub-Action List.  This is very useful when you have common actions that you repeat throughout an action
list. 
 You can also define separate action lists for each target and run each list using this action. 
 There are two different types of Sub-Action Lists available.  
 The first is simply a Named Sub-Action that is part of the Main Action.  All aspects of the Sub-Action
are saved with the Main Action and reside in memory while you are editing and running the Action Lists. 
 The second is a Sub-Action List linked to a CCD Commander Action List File.  This is primarily for
backwards compatibility, but can also be used to create common actions that you always use (Startup
Action List, Shutdown Action List, etc.).  These Sub-Action Lists load the details from a different file
than the Main Action List resides in.  This type of Sub-Action can only be viewed (not edited) since the
list is linked to a specific file. 
 You can Unlink the list from the file.  This will convert the Sub-Action to the first type described above. 
This provides full editing capabilities. 
 You can also save a Named Sub-Action and convert it to a Linked Sub-Action. 
 The Run...
 radio buttons select how CCD Commander should execute the action list. 
 Run Once
 runs the Sub-Action List once and then completes this action - resuming the parent action list. 
 Run until Aborted will repeat the action list forever until you push the Stop button on the CCD
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Commander main window, or something else causes the Sub-Action List to exit (a Skip Ahead action, or
a Plate Solve 
action). 
 Run Multiple Times
 runs the action list for as many times as specified in the text box. 
 Run for a Period of Time
 runs the action list until the amount of time specified is exceeded.  CCD Commander will not interrupt
the action list, so it will wait for the list to complete even if the time limit is exceeded.  If the action list is
very long, the time limit could be exceeded by a significant amount. 
 To close the Sub-Action List tab, click the small 
button in the upper right corner of the tab. 
 Multiple Sub-Action levels: 
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Park Mount Action

   Real Park 
This action will park the mount.  After parking the mount, CCD Commander will disconnect from the
mount. 
 Home & Tracking Off 
This will attempt to send the Home command to the mount and disable tracking.  Some mounts may not
support this feature. 
 Tracking Off 
This will attempt to turn off the mount's tracking.  Some mounts may not support this feature. 
 Simulated Park 
This will cause CCD Commander to simulate a park function by repeatedly slewing to the same
Altitude/Azimuth coordinates specified.  CCD Commander will continue to keep the specified
coordinates centered even while running other actions.  At the end of the Action List, if the Simulated
Park is still active CCD Commander will continue to keep the target coordinates centered until the Stop
 menu or button is pushed. 
 Park Rotator will also park the rotator in its Home
 position. 
 The mount will remain parked (Real or Simulated
) until an action requiring information from the mount takes place. 
 The 
Take Image Action using a "Light" frame will un-park to the mount.  Using any other frame type (Dark,
Bias, or Flat-field) will not reconnect to the mount. 
 The following actions will also un-park to the mount: 
Move to RA & Dec Action 
Plate Solve and Sync or Offset Action 
Automatic Flat Action 
 All other actions will leave the mount in its parked state. 
 When you want to execute one of the Wait actions, it can be a good idea to first issue a Park Mount
Action
. 
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Comment Action

  This action simply inserts a comment text into the Action List and the Status Log.  This can be useful to
self-document action lists for better readability and understanding. 
 The first line in the text box will be visible in the Action List and the full text of the comment will be
added to the Status Log. 
 The Send Comment as E-Mail 
check box will cause CCD Commander to send the comment text to your specified e-mail recipients.  
(Note: 
Comment e-mails must be enabled in the E-Mail tab of the Setup Windows.) 
 Do not skip this action
 will cause the Comment to be added to the log (and e-mailed if enabled) if this action is passed in the
action list even due to a Skip action skipping the action before and after this action. 
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Import Target List

  The Import Target List function is used primarily for survey work.  You must use an external program
(like TheSky) to create a comma delimited target list.  The target list must contain the Target Name, RA,
and Declination coordinates for each target.  The target list must also be in a format exactly like this: 
NGC 5194, 13.50211, 47.1684 
NGC 5195, 13.50401, 47.2418 
NGC 5198, 13.50741, 46.6449 
 Where the first column is the Target Name, the second column is the RA coordinate and the third
column is the Declination coordinate.  The three columns must be separated by commas.  There can be
any number of spaces between each column.  After the Declination coordinate there must be either a
carriage return or another comma. 
 You can select your target list by pushing the "..." button and browsing to the proper file.  The path and
file name will then be listed in the Target List
 field. 
 In the Actions for Each Target list, you can add any number of actions from the Actions
 window.  When importing the target list, CCD Commander will repeat the actions listed here for every
target in the target list.  CCD Commander will insert the data from the target list into each action as
necessary to build your action list. 
 The File menu items will open and save CCD Commander Action List Template (.alt) files.  These are
specifically for the Import Target List function.  If you want CCD Commander to remember what actions
you've setup for the Import Target List window, save the list under the file name,
"ImportActionTemplates\DefaultTemplate.alt".  CCD Commander will always automatically open this file
when displaying the Import Target List
 window. 
 The items in the Edit
 menu perform just like those in the main CCD Commander window. 
 The Actions menu contains a sub-set of actions available in CCD Commander.  Only those actions that
may need to be executed for every target in the list are shown in the Import Target List 
window. 
 The three Import...
 buttons at the bottom of the window will perform the actual import process. 
 The Import To File
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 button will save the new Action List to a new file that you can later open in CCD Commander. 
 The Import to Main List button will clear the Main Action List in CCD Commander (like pushing the
New 
button on the Main CCD Commander window) and then import the new actions into the Main Action
List. 
 The Import as Sub-List button will create a Run Sub-Action List 
action in the Main Action List and then import the new actions into the Sub-Action List. 
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CCD Temperature Graph

  This window shows a graph of the CCD temperature and thermoelectric cooler power.  The CCD
temperature is graphed in red.  The cooler power is graphed in green.  In addition there is a dashed line
showing the trend of the CCD temperature over time. 
 The Stop button will stop recording of the temperature data.  The button will change its text to 
Start to indicate that pushing the button again will start recording the temperature data. 
 The 
Clear button will clear the existing data in the graph. 
 The Save
 button allows the data to be saved in a comma delimited text format for evaluation or preservation of the
data. 
 The Update Interval
 setting tells CCD Commander how often to query and plot the temperature and cooler power.  The
update interval can be set from 5 to 30 seconds. 
 These graphs are a very useful tool to check that your imaging session did not have any temperature
problems. 
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Autoguider Error Graph

  These graphs show the autoguider error while the autoguide process is running and an image is being
exposed.  CCD Commander does not plot the error while the autoguider is being setup, or while
dithering.  These plots will show the guide error that occurs only while your images are being exposed. 
 The Save
 button allows the data to be saved in a comma delimited text format for evaluation or preservation of the
data. 
 The 
Clear button will clear the graphs. 
 These graphs are a very useful tool to check that your imaging session did not have any severe
autoguider problems.  
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Creating Target Lists in
TheSky6
 It is quite simple to create a target list in TheSky6 using the Data Wizard 
tool. 
 This procedure will show how to create a simple target list of all the Messier objects higher than 45°
altitude at the current time. 

1.
1.  Open TheSky6. 
2.
2. Click the 
2. Data->Data Wizard menu (or push Ctrl-Shift-W). 
3.
3. In the Data Wizard window, click the 
3. Query->Edit Parameters... menu 
4.
4. Go to the Object Types and Databases 
4. tab. 
5.
5. Under Select object types, mark the box next to Non-stellar.  (Note: You have to expand the

object type list to select all the possible object types in the list.  Ensure the Selected object types
5.  list shows all the object types you are interested in.) 
6.
6. Under Select databases/catalogs, expand the Non-stellar list and mark the M item.
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6.
7.
7.  Go to the Attribute Filter
7.  tab. 
8.
8. Double click on the Floating Point Values item in the Attribute List
8. . 
9.
9. Click on the Altitude 
9. item. 
10.
10. In the Current Filter section, the Compare selection, select Greater than or equal
10. . 
11.
11.Enter 45 into the Value
11.  field. 
12.
12.Click the Add Filter button.
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12.
13.
13.  Go to the Report Columns 
13. tab. 
14.
14.Double click on the Floating Point Values item in the Attribute List
14. . 
15.
15.Mark the RA and Dec attributes (you can choose either the current epoch or epoch 2000

values).
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15.
16.
16.  Click the Database Query 
16. tab. 
17.
17.You will see a summary of your settings here.  Confirm everything looks correct. 
18.
18. In the Angle/time format section, make sure Decimal degrees is selected.

Page 75



18.
19.
19.  Click the OK
19.  button. 
20.
20.Back in the Data Wizard window, click the Run button.

20.
21.
21.  Click the Data->Export 
21.menu item. 
22.
22.Select the file name to export the list to.  Ensure the other parameters are as shown here:
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22.
23.
23.  Click the 
23.Export button. 
24.
24.You are done with TheSky6 now, close out the open windows. 
25.
25.The resulting text file needs to be slightly edited to be used in CCD Commander.  My text file

looks like this (yours will be slightly different depending on the objects visible at the time you do
the above procedure):

25.Object name,RA (epoch 2000),Dec (epoch 2000) 
M 103,             1.55603,       60.6581   
M 76,              1.70503,       51.5714   
M 34,              2.70139,       42.7617   
M 38,              5.47844,       35.8550   
M 37,              5.87175,       32.5531   
M 36,              5.60492,       34.1408   
M 45,              3.78333,       24.1167   
M 1,               5.57553,       22.0144   
M 35,              6.15000,       24.3500   
M 78,              5.77939,        0.0694   
M 43,              5.59203,       -5.2675   
M 42,              5.58808,       -5.3903

26.
26.  The first line of the text file is a header that TheSky6 inserts.  Remove the first line to use the file

in CCD Commander. 
27.
27.Save the text file. 
28.
28.Now you can import this target list into CCD Commander. 
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Command Line Arguments
 There are several functions that can be accessed via the CCD Commander command line.  These can
be accessed via the Windows Command Shell, the Run window, a batch/scripting file, or similar. 
 The CCD Commander command line is broken down into three parts shown here: 
 CCDCommander.exe <Command> <Argument1> <Argument2> ... <ArgumentX> 
 The first thing must always be the CCD Commander executable name.  The .exe
 extension is optional. 
 Next is the Command. 
 This is followed by any number of Arguments as defined for the command. 
 The available Commands and their respective arguments are: 
 Command: 
AutoRun 
The AutoRun command has one argument which must always be included.  CCD Commander will load
the specified file name and automatically begin execution. 
 Argument: 
FileName 
This must be the name and path of a valid CCD Commander action list. 
 Example usage: 
CCDCommander.exe AutoRun "C:\CCD Commander\MyAction.act" 
This will reset both the Window Position and the MaxIm/DL Sequence Number. 
 Command: 
Reset 
The Reset command can have any number of arguments, but they all must be one of the following. 
 Argument: 
WindowPos 
Resets the startup position of the CCD Commander main window to the default position.  Used if the
startup window position becomes corrupted causing the CCD Commander window to appear off the
screen. 
 Argument: 
MaxImCount 
Resets the Sequence Number used for saving images taken using MaxIm/DL.  
 Argument: 
All 
Resets all of the saved settings in the Windows Registry.  Reverts all of the values in every CCD
Commander window to their default values. 
 Example usage: 
CCDCommander.exe Reset WindowPos MaxImCount 
This will reset both the Window Position and the MaxIm/DL Sequence Number. 
 Command: 
Import 
The Import command must always have two arguments.  It will execute the Import Target List 
function. 
 Argument1: 
TargetListFile 
Specifies the name of the text file containing the target list. 
 Argument2: 
ActionListFile 
Specifies the name of the action list file that the new action list will be written to. 
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 Example usage: 
CCDCommander.exe "C:\Program Files\CCD Commander\TargetLists\TargetList.txt" "C:\Program
Files\CCD Commander\Actions\ActionList.act" 
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File Name Builder

  The File Name Builder is a simple tool to allow you to setup the automatic file naming parameters in
your filenames.  You do not have to use the File Name Builder 
if you can remember the parameters - just type them into the text box where needed.  But this windows
makes it convenient to create file names, and there is nothing to remember! 
 Select the parameter you wish to add from the list, and then click the Add to Filename button.  This will
append the selected parameter into the 
Filename text box. 
 The Filename
 text box is fully editable.  You can insert any other text you want to include in the file name.  Just be sure
not to change the texts between the <> characters, as this will create an invalid parameter. 
 The Example
 text shows a sample file name that will be created with your given parameters.  You can use this verify
your file name. 
 Clicking the Ok button will insert the text from the Filename
 text box back into the action setup window. 
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Correcting the "Permission
denied" error with CCD
Commander
 With the v1.2 release of CCD Commander, a few users have reported an error when CCD
Commander attempts to connect to either CCDSoft or MaxIm DL.  CCD Commander reports that
“Error Number: 70” has occurred.  You might see a screen similar to this: 

   This error is the result of a permission problem with Windows.  There is a simple fix that needs to be
performed with Windows to prevent this error from occurring. 
 I’ve documented the procedure for Windows XP and Windows 2000: 
 1. Click Start->Run. 
2. Type in dcomcnfg.exe into the Run window. 

  3. Click the OK button. 
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4. Windows XP Only: Click the “Component Services” text on the left half of the window (arrow #4
below). 

  5. Windows XP Only: Click the computer icon on the toolbar (arrow #5 above). 
6. On the new window that opens, click the “Default Properties” tab. 
Windows XP: 
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 Windows 2000: 

  7. Change the “Default Authentication Level” to “None” as shown above. 
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8. Confirm that the “Default Impersonation Level” is set to “Identify”. 
9. Click OK and close the “Component Services” window. 
10. Reboot your computer. 
11. CCD Commander should now execute normally. 
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